ALTERA INSTALLATION



Introduction

Fortunately most of you have already used
Altera in CSE 140L, so things will largely be
the same for you.

If you haven't, its basically an IDE for
hardware design
At least B250 and B260 have Altera installed,

but the labs are very crowded this quarter so
you may want to install it yourself as well.
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Step 1: Go to

Step 2: Select whatever version you choose
(We will support the Windows version since
that is what is on the machines in the lab, but
there are Linux installs available as well.

Step 3: Option 1 requires Java, If this Iis not to
your liking (I wouldn’t blame you given recent
events), you can download the file directly.
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Step 4. When asked to create an account, you
can just choose the “One-Time Access” option,
using an email and “UCSD” for the business.

Step 5: IF you did step 3 and downloaded the file
directly, you may also need to download Modelsim
separately. You can find Modelsim here:

Download the stock 11.0 version first, use spl only if
there are problems.


https://www.altera.com/download/software/modelsim-starter/11.0
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Step 6: Once the process to create your account
IS done, you can sign in to install the file.

Step 7: Downloading a 2.7 GB takes time...try
downloading on campus. Grab a coffee.

Kidding aside, this highlights another issue with
Altera, installation takes time, do it asap.

Step 8: If you used the download manager you
should have Altera auto-install for Quartus Il Web
Edition and Modelsim-Altera Starter Edition

There are paid versions of this, make sure to get the
free ones.
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Step 8b: If you downloaded manually make sure you
have these two programs and ensure that the Cyclone
and Stratix FPGA libraries are installed as well.

Step 9: Once you begin the installation...you can
safely step away.

You can probably cook a nice dinner, this can take well
more than an hour to install fully.

As such this is another reminder to install this ASAP, the
basement labs appear swamped this quarter so space is at
a premium.

Step 10: You do not need a license, so if something
pops up asking for one ignore it.

Step 11: Fin!



ALTERA/VERILOG
TUTORIAL



Altera Tutorial

This tutorial is adapted from the CSE 141L Lab
1 from Summer 2012 (available here:
http://cseweb.ucsd.edu/classes/sul2/csel41L-

a/labl.nhtml).

It will show how to set up a project, write a
couple Verilog files, then test them.

It is NOT designed to show you how to do your
lab, as such the ALU Is very simple, but it may
give you ideas on how to implement your
project.



Altera Tutorial

Some additional (and more detailed) tutorials
can be found on Piazza.

One covers how to set up a project in Altera

The other covers how to do simulations using
ModelSim

Even further help can be found here:
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Step 1. With Altera open, go to File -> New Project
Wizard...

Step 2: Type the name of the project and the
directory you want to place it in. Click next to pass
step 2.

Step 3. When you reach Step 3: Select the Cyclone
Il family and the EP2C35F672C6 chip.

Step 4: For “Simulation™: Click the tool name drop
box and select “Modelsim-Altera”, for the format:
“Verilog HDL”

Step 5: Verify that you did the above on the
Summary screen.
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Summary [page 5 of 5]

When you dlick Finish, the project will be created with the following settings:

Project directory:
Project name:
Top-evel design entity:
Number of files added:
Number of user libraries added:
Device assignments:
Family name:
Device:
EDA tools:
Design entry/synthesis:
Simulation:
Timing analysis:
Operating conditions:
VCCINT voltage:
Junction temperature range:

C:\Users\Mark\Desktop
Tutorial
Tutorial

Cydone IV GX
EP4CGX150CF23C7

<None> (<None>)
ModelSim-Altera (Verilog HDL)

<None> (<None>)

L2y
0-85°C

[ < Back ][ Next > ][ Finish

J [ concel ]

Help

)
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o Sidebar: What the is a Cyclone |l
EP2C35F672C67

Short answer: It is an FPGA designed by Altera that
allows you to translate your schematic/verilog onto
an actual chip.

Table 1. Cyclone IV GX FPGA Family Overview

Dewice EPACGX1S5 | EPACGX22 | EPACGX30 |  EPACGXS50 EPACGXTS | EP4CGX110 | EPACGX150
Logic elements (LEs) 14,400 21,280 29,440 49 588 73,920 109, 424 149,760
MOK memory blocks 50 84 120 278 462 610 720
Embedded memory 540 756 1,080 2,502 4,158 5,490 6,480
(Kbits)
18-bit x 18-bit o 40 80 140 193 280 360
multipliers
PCIe® hard IP block 1 1 1 1 1 1 1
Phase-locked loops 3 ] 4 8 3 3 8
(PLLs) (1)

2 4 4 8 g g 8
Transceiver I,/0s
Maximum user I/0s 72 150 290 310 310 475 475
Maximum differential 25 64 109 140 140 216 216
channels
Availability Buy Mow Buy Mow Buy Mow Buy Mow Buy Mow Buy Mow Buy Mow
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Sidebar: What is a Cyclone || EP2C35F672C6?

We will not be actually doing putting your design on-
chip, but other classes have attempted it, and some
of you have experience in CSE 140L. We would like
you to use the package denoted in Lab 2 for your
testing.

The reason we want this is because, Iif you are
arguing area or speed of the processor, the chip
matters. If you are arguing something like cycle
count, then this is less of a concern.
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Step 6: Go to File-> |

View  Proj Tods Window Hep &
Do 8 * | [Tutoral - 24
Project Navigator ax| & Tutorialy
"= m | [entey AT FFE 4X3K%% 08 B 0.
X
> Tutori

Verilog HDL File to

start coding up
components. Be
sure to save your
filles in the same e
directory as your

project.
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o Step 7: Insert the following
code:

assign wireOut = regA + regB;
‘“timescale 1lns / 1lps assign out = regOut;
assign is0dd = regOdd;

module Tutorial# (parameter W = 8)

( always@ (posedge clk)

input clk, begin

input [W-1:0] inA, inB, regh <= inh;

output [W:0] out, regB <= 1inB;

output is0dd regOut <= wireOut;

) ; reg0dd <= (out[0] == 1) 2 1: O;

end

reg [W-1:0] regA, regB;
reg [W:0] regOut; endmodule
reg regOdd;

wire [W:0] wireOut;
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Step 8: Now its time to check to make sure
everything is syntactically correct. Go to the tasks
tab, and double click on “Analysis & Synthesis”.
This will compile the code and show you any
errors that may crop up in compilation.

Step 9: If you want to see how things look at the
RTL level, go to the hierarchy tab, right click your
base module (in this case: Tutorial), go to Locate,
and select “Locate in RTL Viewer”
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ﬁeﬁit%ewﬁmedwm\gnobmﬂeb@

DEEG@ S & BB © ~ [uoa XY @RS TP DO Y L e
EEEcaeing gx | & Tutorial.v e e Compilation Report (] l
Entity @ A:Bﬁ iE &£ A% %% @S@ggibfl_'g'%
&) Cydone IV GX: EP4CGXS0CF23C7 7 ‘_ ¥ &
I Tutorial . 8
& Settings... Ctrl+Shift+E 9 [Hmodule Tutorial# (parameter W = 8)
0 Ft
~ locate 4 Locate in Assignment Editor
Copy ctrl+C Locate in Pin Planner =
Locate in Chip Planner (Floorplan and Chip Editor)
Expand Al Locate in Resource Property Editor
G A Locate in Technology Map Viewer
Print Hierarchy Locate in RTL Viewer
Print All Design Files Locate in Design File
Tess g : El
ﬁ & 2 assign wireOut = reghA + regB; I
Flow: | Compilation ~ ] Customize. ] 23 assign out = regOut; E
Task :; assign isOdd = regOdd:;
v 4 P Compile Design 0 26 always@ (posedge clk)
v b P Analysis & Synthesis 0 27 [Hbegin
v > P Fitter (Place &Route) 0 28 Tegh <= ink;
v > P Assembler (Generate programming files) 0f 29 regB <= inB'
< b P TaneQuest Timing Aralysis of g: i:ﬂ; :: ‘::::?g;_ 5 R
v b W EDA Netlist Writer of = i T
@ Program Device (Open Programmer) 33 L
34 endmodule =
30| il Al i 0
5 -
5 Type Message
\'y Info: Quartus II Full Compilation was successful. 0 errors, 19 warnings Ij
g e ~ = = _— 2
§ Processing (119 mm itical Warni 6 a
|Messwe 0of 268 @ [Locauon vH Locate ]

Chme the Settings 100% 00:01:46



Altera Tutorial

& RIL Viewer - C/Users/Mark/Dropbou/Tutorz |,
Fie Edit View Tools Window Help &

: Page Tile{ Locate |Page:{T0f1_v] @ B Hagy

Find & x

5.

regBI7..0] “s[;.

regQOut{8..0]

regOdd

isOdd

Eoutis.0)

100%

00:00:11
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Step 10: Repeat steps 6-8 for any other modules
you wish to create. While we don’t show it here,
eventually you will have to wire up all your
modules either using a schematic viewer or in
verilog.

Step 11: To see how it will work in simulation, we
need to use modelsim. Open Modelsim up.

Step 12: Go to File -> New... -> Library. Create a
new library with the radio button “a new library
and a logical mapping to it” selected.
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File Edit View Compile Simulate Add Library Tools Layout Window Help
dlBO2IO-AFBN | o

<

Name Type Path 2
Ji) work (empty) Library  work
(=il 220model Library  $MODEL_TECH/.. /alterajvhdl/220model
[+l 220model_ver Library ~ $MODEL_TECH/../altera/verilog/220m...
[+l altera Library ~ $MODEL_TECH/..faltera/vhdl/altera
E)—‘L altera_Insim Library SMODEL_TECH/. . faltera/vhdl/altera_l...
(=l altera_insim_ver Library ~ $MODEL_TECH/.. /altera/verilog/altera...
[+l altera_mf Library ~ $MODEL_TECHY/../alterajvhdl/altera_mf
@-ﬂ altera_mf_ver Library SMODEL_TECHY/.. /altera/verilog/altera... i
[+l altera_ver Library ~ $MODEL_TECHY/.. faltera/verilog/altera
[+l altoxb Library  $MODEL_TECHY/.. /alterajvhd/altgxb
@-ﬂ altgxb_lib Library $MODEL_TECH/. . faltera/vhdl/altgxb
M altgxb_ver Library $MODEL _TECHY/.. faltera/verilog/altgxb g
++li} arriagx Library ~ SMODEL_TECHY/../altera/vhdl/arriagx M Create a New Library
(x4l arriagx_hssi Library ~ $MODEL_TECH/..faltera/vhdlfarriagx_... Gk
(=14l arriagx_hssi_ver Library ~ $MODEL_TECHY/../altera/verilog/arriag... nenitiary
= arriagx_ver Library $MODEL_TECHY/.. faltera/verilog/arriagx o
w4 arriaii Library ~ SMODEL_TECH}../alterajvhdl/arriai € amap to an existing lbrary
(&4l arriai_hssi Library  $MODEL_TECHY../alterajvhdlfarriai_hssi @ anew library and a logical mapping to it
(x4l arriaii_hssi_ver Library ~ $MODEL_TECH)/.. /altera/verilog/arriaii... T
(214l arisii_pcie_hip Library  $MODEL_TECH/../alterajvhdl/arriaii_p... r Lo ‘
@-‘L arriaii_pcie_hip_ver Library SMODEL_TECH/.. falteraverilog/arriai... |"°rk
= arriaii_ver Library $MODEL_TECH/.. faltera/verilog/arriaii :
4l arrisigz Library  SMODEL_TECH/. falterajvhdl/arriaiigz ’;o::my Physdcol Nome ‘
[+l arriziigz_hssi Library ~ $MODEL_TECHY/.. falterajvhdl/arriaiigz. ..
[+l arriaiigz_hssi_ver  Library ~ $MODEL_TECH/../altera/verilog/arriaii...
[+l arriaiigz_pcie_hip  Library  $MODEL_TECHY../altera/vhdl/arriaiigz...

(x4l arriaiigz_pcie_hip_v...Library ~ SMODEL_TECH/../altera/verilog/arriaii...

[+l arriaiigz_ver Library ~ $MODEL_TECHY/.. /altera/verilog/arriaiigz

wiHl cvelane lihrary SMODFI TFCH/... [alterafvhdllevclone ¥
[ Transcript HE Hdl X
# ** Warning: Copied C:\altera\ll.0Ospl\modelsim ase\win32aloem/../modelsim.ini to modelsim.ini. &
# Updated modelsim.ini.

ModelSim >

[<No Design Loaded> <No Context> )
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Step 13: Create a file called “test_tutorial.v’, to

set

up the testbench (see next slide)

Step 14: Go to compile->compile. Select
BOTH the Tutorial.v and test_tutorial.v files to
compute.

Ste
clic
Ste

0 15: Go to your work library and double
K “test_tutorial.v”

0 16: Go to the top bar, change 100ps to

100ns, DO NOT hit run yet.
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S =

“timescale 1lns / 1lps // Test with a variety of inputs.
// Introduce new stimulus on the falling clock edge so that
values
module test tutorial# (parameter W = 8);
- // will be on the input wires in plenty of time to be read by
// registers on the subsequent rising clock edge.
reg clk;
initial
reg [W-1:0] a r;
- begin
reg [W-1:0] b r;
_ ar=0;
wire [W:0] sum;
b r =0;

wire is_odd;
- @ (negedge clk);

ar=1;
// The design under test is our adder b .
r = 1;
Tutorial dut ( .clk(clk)
@ (negedge clk);
,.inA(a r)
— ar=25;
,.inB(b r)
_ b r = 6;
, -out (sum)
@ (negedge clk);
, .1s0dd (is_odd)
_ ar=2;
b r=2;

@ (negedge clk);
// Toggle the clock every 10 ns

ar = 3;
b r = 3;
initial
@ (negedge clk);
begin
ar=1;
clk = 0;
b r = 8;

forever #10 clk = !clk;
end // initial begin

end

endmodule // test_adder
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™ ModelSim ALTERA STARTER EDITION 6,63

File Edit View Compile Simulate Add Structure T!s Layout Window Help
0-@ 2 O-MELT||CHRA|| @t «s |F woEBBHNS [ HPEB 9 WS || x0X % || oot vl
ColumnLayout [311Columns vl J [ 8 o8 25
5 ]| |$a objects Har x|
Instance Design unit  |Design unit type  |Visibility  |Total coverage
:} ' tﬁ;t_m !ﬁt_mhlﬁ Module +acc=... : Parameter Internal
o+ dut Tutorial Module +acc=... dk 2 Internal
& #INITIAL#36 test_tutorial Process a_t 0 , Array Internal
& FINITIAL#46 test_tutorial Process N,
| #vsim_capacity# Foreign +acc=...

Intern;

# Processes (Active)

Hl x|

A orery ] & s |

f-4 Transcript Hd x|
# Loading work.Tutorial ;I
VSIM 6> run
VSIM 7>
-
Now: 100 ns Delta: 3 | sim: ftest_tutorial
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Step 17: To see the waveform, right click “dut”, go
to Add -> To Wave -> All items in region

Step 18: Now hit run. Right click the waveform
and select “Zoom Full” (or press F).

Step 19: If you did everything properly, the
waveform should be displayed as shown here.

Step 20: Note that the adder has a delay between
the input and the correct output. This was by
design. Be careful when coding in verilog not to
have too many registers in your modules as this
can slow down your processor.
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™ ModelSim ALTERA STARTER EDITION 6.
File Edit View Compile Simulate Add Structure Tools Layout Window Help

0-5 @ O-MEBN||SHAA| @/t €= F 0 =HESBAC  MPEB-U WO |
Coluanavcut[Allcﬂu,mS !] H Eg‘mg” Kﬁl@ : = 5 J 6% &} J

Elsm H i x| | §aObjects Hdl x|
Vilnstance Design unit lDesagn ur
=+ test_tutorial test_tutorial Module 8

+ g it Tutorial Module 3 St0

XX

| [ 1 [ I | [
[test_tutorial/dut/inA 000000001 00000001 00000101 00000010 00000011

- j -:Ihf‘rl"fi :::: ;‘fs?:;:’;::n ocess g gggﬁggg; /mt_m (00000000 00000001 [00000110 00000010, 100000011
I o éapai ; IEst.mWIwﬂout o 30K 000000010 000001011 J0000...._
= N Add To Wave All items in region Jtest_tutorial/dutfs... { . =]
oy To List » Allitems in region and below Mst_m/mdr... OO, .. ?DODODO 1 0 1 DGDDD, pe
Fed.. I SR N § el e ——
— | ToDataliow]} 000000100 X g 2 ooe s 0000101
Expand Selected 4 regOdd 1 = !

Jtest_tutorial/dutfw... o [D00000000 000000010 J000001011 000000100 J00000....

Collapse Selected 4 wireOut 000000110
Expand All _b_'
Collapse All —

# Processes (Active) Hd X
Code Coverage » '1Name IType (filtered) |5ti

»
XML Import Hint

Reload sim
End Simulation

100000 ps |8
0ps

Kl |
!]! Library @ sim

q Transcript

el
=

Vs s> restart -z
VSIM 10> run

VSIM 11>

Now: 100 ns Delta: 3 [sim:/test_mhorialldut
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